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7.

10.

11.

12.

Third-party owners from whom Bay Networks has acquired license rights to software that is incorporated
into Bay Networks products shall have the right to enforce the provisions of this license against licensee.

Licensee shall not remove or obscure any copyright, patent, trademark, trade secret, or similar intellectual
property or restricted rights notice within or affixed to any Software and shall reproduce and affix such
notice on any backup copy of Software or copies of software resulting from modification or combination
performed by licensee as permitted by this license.

Licensee shall not reverse assemble, reverse compile, or in any way reverse engineer the Software. [Note:
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amended from time to time) shall apply for interoperability purposes. Licensee must notify Bay Networks
in writing of any such intended examination of the Software and Bay Networks may provide review and
assistance.]

Notwithstanding any foregoing terms to the contrary, if licensee licenses the Bay Networks product “Site
Manager,” licensee may duplicate and install the Site Manager product as specified in the Documentation.
This right is granted solely as necessary for use of Site Manager on hardware installed with licensee’s
network.

This license will automatically terminate upon improper handling of Software, such as by disclosure, or
Bay Networks may terminate this license by written notice to licensee if licensee fails to comply with any
of the material provisions of this license and fails to cure such failure within thirty (30) days after the
receipt of written notice from Bay Networks. Upon termination of this license, licensee shall discontinue
all use of the Software and return the Software and Documentation, including all copies, to Bay Networks.

Licensee’s obligations under this license shall survive expiration or termination of this license.
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About This Guide

If you are responsible for activating a Wellfleet® router on your IP
network, this guide can help you

a  Configure the router’s initial IP network interface.

o Install the router’s remote management application, Site Manager.
o Use Site Manager to create a pilot configuration for the router.
These tasks are all part of the Quick-Start procedure. When you finish

the procedure, the router will be actively routing IP traffic on your
network.

Note: This guide is intended for first-time installations. If you are
upgrading from a previous release, use only those sections of
this guide that are referred to in the upgrading instructions in
the appropriate upgrade guide:

— Upgrading Wellfleet Routers from Version 5 to Version 8.10
— Upgrading Wellfleet Routers from Version 7-8.00 to Version 8.10
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How to Get Help

Before You Begin

Before using this guide, you must install the router. For instructions,
see the installation manual that came with your router.

How to Get Help

For additional information or advice, contact the Bay Networks Help

Desk in your area:
United States
Valbonne, France
Sydney, Australia
Tokyo, Japan

Conventions

angle brackets (< >)

arrow character (=)

brackets ([ ])

user entry text

command text

italic text

screen text

1-800-2LAN-WAN
(33) 92-966-968
(61) 2-903-5800
(81) 3-328-0052

Indicate that you choose the text to enter based on
the description inside the brackets. Do not type the
brackets when entering the command. Example: if
command syntax is ping <ip_address>, you enter
ping 192.32.10.12

Separates menu and option names in instructions.
Example: Protocols->AppleTalk identifies the
AppleTalk option in the Protocols menu.

Indicate optional elements. You can choose none,
one, or all of the options.

Denotes text that you need to enter. Example: Start
up the Windows environment by entering the
following after the prompt: win

Denotes command names in text. Example: Use the
xmodem command.

Indicates variable values in command syntax
descriptions, new terms, file and directory names,
and book titles.

Indicates data that appears on the screen. Example:
Set Trap Monitor Filters

Xii



About This Guide

ellipsis points

Horizontal (. . .) and vertical ( : ) ellipsis points
indicate omitted information.

quotation marks (“”) Indicate the title of a chapter or section within a

vertical line (|)

Acronyms

ANSI
ARP
ATM
BGP
BOOTP
CMIP
EGP
FDDI
FTP
IEEE
ILI

IP
IS-IS
MAC
MOP
NVFS
OSI
OSPF

book.

Indicates that you enter only one of the parts of the
command. The vertical line separates choices. Do not
type the vertical line when entering the command.

Example: If the command syntax is
show at routes | nets, you enter either
show at routes or show at nets, but not both.

American National Standards Institute
Address Resolution Protocol

Asynchronous Transfer Mode

Border Gateway Protocol

Bootstrap Protocol

Common Management Information Protocol
Exterior Gateway Protocol

Fiber Distributed Data Interface

File Transfer Protocol

Institute of Electrical and Electronic Engineers
intelligent link interface

Internet Protocol

Intermediate System to Intermediate System
media access control

Maintenance Operations Protocol
Non-Volatile File System

Open Systems Interconnection

Open Shortest Path First

Xiii



Acronyms

PCMCIA

PvVC
QENET
RIP
SMDS
SNAP
SNMP
SRM
SvC
TCP/IP
TFTP

Personal Computer Memory Card International
Association

permanent virtual circuit

Quad Ethernet Link Module

Routing Information Protocol

Switched Multimegabit Data Services
Subnetwork Access Protocol

Simple Network Management Protocol

system resource module

switched virtual circuit

Transmission Control Protocol/Internet Protocol
Trivial File Transfer Protocol
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Chapter 1
Before You Begin

Read this chapter before you activate the Wellfleet router for
information on the following topics:

o Reviewing the Quick-Start procedure
o Configuring the router after Quick-Start
0  Quick-Start prerequisites
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Reviewing the Quick-Start Procedure

Reviewing the Quick-Start Procedure

Quick-Start is the initial configuration procedure that activates the
Wellfleet router on your network. You can Quick-Start the following
Wellfleet routers:

a

o o o o o o Q

Access Feeder Node (AFN™)

Access Link Node (ALN)

Access Stack Node (ASN™ )

Backbone Concentrator Node (BCN™ )
Backbone Link Node (BLN®)
Concentrator Node (CN™)

Feeder Node (FN™)

Link Node (LN™)

You complete the Quick-Start procedure in four steps:

1.
2.

3.
4.

Fill out the Network Information Worksheet.

Use the Technician Interface to configure the router’s initial IP
interface.

Install Site Manager software on a network device.

Use Site Manager to configure the router remotely.

The following sections briefly describe each step.

Filling Out the Network Information Worksheet

You complete the Network Information Worksheet to assemble the
network information you need to Quick-Start the router (for example,
the IP address and subnet mask of the router’s initial IP network
interface). Chapter 2 describes how to use the Network Information
Worksheet.
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Before You Begin

Using the Technician Interface to Configure the Router’s Initial IP Interface

You configure and manage the router using Site Manager, a remote
graphical user interface that runs on a workstation located on the IP
network. For Site Manager to communicate with the router, you
establish an initial IP network interface between the router and the
Site Manager workstation (Figure 1-1).

Corporate IP Network

Site Manager
Workstation

Use the Technician
Interface to configure
the initial IP interface. —— 192.32.156.7

-

==
Router

—

ASCII Console or PC

Figure 1-1. Using the Technician Interface to Configure the Initial IP Network
Interface

You use the Technician Interface operating in the router to configure
the initial IP interface. The Technician Interface displays a command-
line where you enter commands. You access the Technician Interface
from a terminal or PC connected to the router’s console port.

Chapter 3 describes how to configure the initial IP interface.
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Configuring the Router after Quick-Start

Installing the Site Manager Software on a Network Workstation

After you establish the initial IP interface between the router and the
workstation, you install the Site Manager software on the workstation
(a PC, SPARCstation™ , RS/6000, or HP® 9000). Site Manager then
uses Simple Network Management Protocol (SNMP) and Trivial File
Transfer Protocol (TFTP) to manage the router over the IP network.

Chapter 4 describes how to install the Site Manager software.

Using Site Manager to Configure the Router Remotely

To configure the router remotely from your Site Manager workstation,
you

o Create a simple pilot configuration file (see Chapter 5).
0 Transfer the pilot configuration file to the router.
a  Boot the router with the pilot configuration.

Creating the pilot configuration tests your Site Manager installation
and familiarizes you with the Site Manager interface.

Configuring the Router after Quick-Start

When you finish the Quick-Start procedure, the pilot configuration
running on the router consists of two IP interfaces:

a  The initial IP interface that you configured using the Technician
Interface to enable router communication with the Site Manager
workstation

0 The second IP interface that you configured using Site Manager to
verify proper Site Manager installation

After you complete the Quick-Start procedure, you use Site Manager to
enhance the pilot configuration to meet your specific network needs.
Refer to Configuring Wellfleet Routers for instructions.
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Before You Begin

Quick-Start Prerequisites

Before Quick-Starting the router:

1. Review the release notes for the Wellfleet system software and
Wellfleet Site Manager software for the version you are installing.

2. Install the router at your site. See the installation manual that

came with the router.

3. Cable the router to the IP network as described in Table 1-1.

Table 1-1.  Instructions for Cabling the Router to the IP Network

Welifleet Router

Cable the IP Network to

AFN/ES XCVRI1 port
AFN/TS MAU1 port
ASN Any port on any net module, excluding

the Stack Packet Exchange (SPX) Module

FN, ALN, LN, CN, BLN, BCN

First port on the link module

4. Cable the router to the PC or ASCII console you will use to
establish a Technician Interface session, as described in the next

section.

Setting Up a PC or ASCII Console Connection to the Router

You must cable the router to the PC or ASCII console you will use to
establish a Technician Interface session. This section describes how to
set up the PC and ASCII console for the router connection.

Note: If you use Site Manager on a PC, you may prefer to use the
same PC to access the Technician Interface and to run Site
Manager. However, to manage the router with Site Manager
you must connect the PC to the IP network.
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Quick-Start Prerequisites

To use a PC to establish a Technician Interface session, you must
install the Windows Terminal Emulation application. Follow these
steps to set the Windows Terminal Emulation parameters and save
them to a file.

Enter win at the DOS prompt to start up Windows.
Double-click on the Accessories icon.

Double-click on the Terminal icon.

Select Settings>Terminal Emulation.

Click on the DEC VT100 (ANSI) option and click on OK.

Select Settings=>Communications.

A R I o

Set the communications options as follows:
— Baud Rate = 9600

— Stop Bits =1

— Parity = none

— Data Bits = 8

8. Click on the COM port you want to connect to the router, and click
on OK. Usually COM 1 is a 9-pin COM port and COM 2 is a 25-pin
COM port.

9. Select File®>Save As.

10. Enter the name of a new file in which to store the communications
settings, and click on OK.

11. Select File=Open.
12. Select the file you just named and click on OK.

To use an ASCII console, set its operating parameters as follows:
— Baud Rate = 9600
— Stop Bits =1
— Parity = none
— Data Bits = 8
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Before You Begin

Once you have set up your PC or ASCII console:

1. Cable the console port of the router to the COM port you selected in
Step 8. You need a 25-pin male-to-9-pin female cable adapter to
connect a PC directly to the router.

2. Power the router on to complete the internal diagnostics and
startup.

The Technician Interface screen displays the Login prompt if the
router is powered on and booted.

3. Connect the Site Manager workstation to the IP network.

Understanding ASN Terminology

Certain terms have different meanings for the ASN than for other
Wellfleet routers. If you plan to Quick-Start an ASN, read this section
before continuing.

The ASN is stackable, which means you can connect as many as four
ASNs together. Site Manager treats all nodes in a stack as a single
router. When you configure the ASN, you need to identify the location
of a net module by specifying

a The slot that contains the net module

In an ASN, the term slot refers to the main processor board. The
ASN slot ID identifies the slot number. You set the slot ID using the
slot ID dial on the ASN rear panel. For information, refer to
Installing and Maintaining ASN Routers.

(For Wellfleet routers other than the ASN, the slot is where the link
module resides.)

1 The module position where the net module resides

Each ASN has four modules, numbered 1 through 4.
If you need to specify the location of a memory card in an ASN, you
must specify the slot that contains that memory card. For example,

suppose you stacked your ASNs. If the node with slot ID 3 contains the
memory card you want, you would specify 3 for the slot.
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Chapter 2
Network Information Worksheet

Before you begin the Quick-Start procedure described in Chapter 3, fill
out a Network Information Worksheet to collect the information you’ll
need to

o Configure the initial IP interface to connect the router to Site
Manager.

a Run the Quick-Start installation script.

The installation script prompts you for information. The worksheet
contains space for the information you should prepare in advance.

Use only the portions of the worksheet that apply to your network
requirements. For example, if you are not enabling OSPF on the IP
interface, skip over any questions that pertain to OSPF.

Many steps in the installation script suggest default values you should
accept. Some steps are optional for your network requirements. For
example, local PAP passwords are optional with PPP.

The examples on the Network Information Worksheet reflect

information from the sample network in Figure 2-1.

Note: Contact your network administrator for assistance in selecting
worksheet options.
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IP Address= 192.32.10.12

Site Manager
workstation

ASCII console
or PC

Corporate IP network

Slot 2 contains a QENET Link Module that
connects this router to the network using
XCVR1 (Ethernet Connector 1) as follows:

IP =192.32.156.7
Subnet Mask = 255.255.255.0

Wellfleet router

o (@) (@) (v [wm) ©

Console port in
Slot 1 of AFN, FN, LN, ALN, CN, BLN, or ASN
or Slot 7 of BCN

Figure 2-1. Sample Network Used In Worksheet Examples
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Network Information Worksheet

Table 2-1.  Network Information Worksheet
Requested Information Example Your Information
Physical Connector Information
For all Wellfleet routers except the ASN:
Slot containing the link module providing the Slot 2
initial IP network interface (this module can
reside in any slot that is designated for link
module support)
Type of link module the slot contains
Quad Ethernet
For the ASN:
Slot and module containing the net module Slot 1,
that provides the initial IP network interface Module 1
Type of net module the module contains Dual Ethernet
For all Wellfleet routers:
Number of the connector (port) providing the 1
initial IP network interface
Connector the initial IP network interface uses | XCVR1

Frame Relay Information

(This section applies only if you use a synchronous connector for this initial IP configuration, and choose to enable

Frame Relay)

Enable Frame Relay on the interface? Yes
Management protocol that communicates with | LMI

the Frame Relay network

DLCI Addressing Types ADDR Q.922
Frame Relay Address Field Length 2 bytes
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Table 2-1.  Network Information Worksheet (continued)

Requested Information

Example

Your Information

Frame Relay PVC ID

30

PPP Information

(This section applies only if you use a synchronous connector for this initial IP configuration, and choose to enable

packets

PPP)

Enable PPP on the interface? Yes

IP address of peer connection 192.32.4.2
Enable PPP Echo protocol? Yes
Number of seconds between transmission of 10

echo requests

Acceptable loss of Echo-Reply packets 3

Enable local authentication protocol? Yes

Local PAP ID for this interface 192.32.4.1
Local PAP password (optional) Ipwd
Authentication protocol enabled on remote Yes

peer?

Remote peer PAP password rpwd
Enable Link Quality Reporting (LQR) protocol? | Yes
Enable use of remote peer’s LQR timer? Yes
Minimum acceptable percentage of inbound 90
packets

Minimum acceptable percentage of outbound 90
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Table 2-1.  Network Information Worksheet (continued)

Requested Information

Example

Your Information

SMDS Information

(This section applies only if you use a synchronous connector for this initial IP configuration, and choose to enable

SMDS)

Enable SMDS on the interface? Yes

Individual Address C1617555433FFFF
Group Address E16175556667FFFF
ARP Address E16175550000FFFF
IP Interface Configuration Information

IP address of this initial network interface 192.32.156.7
Subnet mask address of this initial network 255.255.255.0
interface (in dotted decimal notation)

Does this interface connect to the same local No

area network (LAN) as the Site Manager work-

station?

IP Routing Protocol to configure to manage OSPF

router remotely. This is necessary only if you
answered No to the previous question.

See the following sections, “RIP Configuration
Information,” “OSPF Configuration Informa-
tion,” and “Static Route to Site Manager Con-
figuration Information,” for details on the IP
Routing Protocol you choose to configure.

2-5



Table 2-1. Network Information Worksheet (continued)

Requested Information Example Your Information

RIP Configuration Information
(This section applies only if you enable RIP [rather than OSPF] on this initial IP interface)

Should RIP listen to the default route to the Y
network or subnet where Site Manager is
located?

OSPF Configuration Information
(This section applies only if you enable OSPF [rather than RIP] on this initial IP interface)

OSPF Router ID 192.32.156.7
OSPF Area Address 0.0.0.0
Enable Simple Password Authentication? No

Upper limit for the maximum transmit unit 4500 bytes
(MTQU) size for OSPF packets

OSPF interface type (Broadcast, NBMA, or Broadcast
Point to Point)

Note: The interface type, Hello Interval, and
Dead Interval must match the current OSPF
configuration of the network.

Hello Interval (in seconds) 10

Router Dead Interval (in seconds) 40

Router Priority 1

Poll Interval 20

If you are configuring OSPF neighbors, what is | Not applicable.
the IP address for each neighbor? Sample format:
Note: Neighbors are defined only if the OSPF 192.32.156.8
interface type is NBMA. 192.32.156.9
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Table 2-1.

Network Information Worksheet (continued)

Requested Information

Example

Your Information

Static Route to Site Manager Configuration Information
(This section applies only if you enable a static route to Site Manager on this initial IP interface)

Destination network 192.32.90.0
Destination network mask 255.255.255.0
Next-hop address that is in the same subnet as | 192.32.4.99
the initial IP interface
Site Manager Workstation Information
IP address of the workstation on which the Site | 192.32.10.12
Manager software will be installed
If you are installing the Site Manager software | 3Com® 3C503 (net-
on a PC, what type of network interface card work card)
and driver(s) are installed on the PC?

3C503.EXE (driver)
Miscellaneous Information
Default volume where TFTP transactions will | 2
take place
Enable TELNET? No
Default volume where FTP transaction will 3

take place
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Chapter 3
Configuring the Router’s
Initial IP Interface

You configure the router’s initial IP interface to establish a link
between your router and the Site Manager workstation over the IP
network.

To create the initial IP interface you:

[m)

a
a
)

Establish a Technician Interface session.
Review the Quick-Start installation files.
Boot the router without configuration.
Run the Quick-Start installation script.

The Quick-Start installation script prompts you to enter the
network information that dynamically configures the initial IP
interface. (Refer to the worksheet that you completed in Chapter 2.)

The instructions in this chapter are customized for the file storage
system on your router.

a0 NVEFS Instructions

The Non-Volatile File System (NVFS) running in the router reads
and writes to memory cards for file storage. Use the NVFS
instructions if you are Quick-Starting an AFN (with a memory
card), ASN, BCN, or BLN.
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a DOS Instructions

The DOS file system running in the router reads and writes to a
disk drive for file storage. Use the DOS instructions if you are
Quick-Starting an AFN (with a disk drive), ALN, CN, FN, or LN.

Note: Your AFN can be configured for either memory cards or a disk
drive. If your FN, ALN, LN, or CN has a SYSCON II module, it
may have both a disk drive and a memory card. Make certain
that the default media is installed for this Quick-Start
procedure.

Establishing a Technician Interface Session

You establish a Technician Interface session with the router from your
terminal (or terminal emulation program on a PC) as follows.

1. Set up a PC or ASCII console connection (refer to Chapter 1).
2. At the Login prompt, enter Manager

Note: Press the Enter key after typing a Technician Interface
command in response to a prompt.

The screen displays the slot where the Technician Interface is
running, followed by the $ prompt, showing that you are logged in
(Figure 3-1).

If the $ prompt does not appear, you may have entered the Manager
command incorrectly. Repeat this step.

Note: The Technician Interface interface is case-sensitive; that is,
the command Manager is not the same as manager.
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Technician Interface
running on Slot 2

Bay Networks, Inc. and its Licensors.
Copyright 1992, 1993, 1994. All rights reserved.

> Login: Manager

> Welcome to the Backbone Technician Interface

(2]

$

Figure 3-1. Technician Interface Screen

3. Ifyou have an FN, ALN, LN, or CN router, perform steps a, b, and c
below. If you have an AFN, ASN, BLN, or BCN, proceed to the next

section.

a.

C.

Enter the following command:
backplane <router_type>

where <roufer_type> is FN, LN, or CN. For example, enter
backplane CN if you have a CN. If you have an ALN, enter
backplane LN.

Boot the router by entering
boot

You must boot the router after issuing the backplane
command.

Log in again as Manager when the Login prompt appears.
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Review the Installation Files

After establishing the Technician Interface session, you are ready to
display the Quick-Start installation files and verify that they are

available.
1. Locate the memory card location (NVFS only).

NVEFS Instructions:

Identify the slot where the router’s memory card (volume)
resides by entering

dinfo

The router’s memory card is the file system residing in the
router. The Technician Interface interface displays a table
showing the memory card’s slot and memory statistics (Figure
3-2). BCNs and BLNs may contain multiple memory cards —
one memory card per slot.

$ dinfo

VOL STATE TOTAL SIZE FREE SPACE CONTIG FREE SPACE

2: FORMATTED 2097152 1458420 1458420

A

$

The volume resides in the slot indicated.

Figure 3-2. Sample dinfo Display (NVFS Only)
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DOS Instructions:
Proceed to Step 2.
Display the names of the files in the volume.
NVFS Instructions:
Enter
dir <slot number>:

to display the names of the files in the volume, where <slot
number > is the memory card’s slot. Enter the colon (:) after the
slot number; it is part of the command string.

DOS Instructions:
Enter
dir A:

to display the names of the files on the disk. Enter the colon (:)
after the volume identifier A; it is part of the command string.

The console displays the files in the volume (Figure 3-3).

35



Review the Installation Files

$ dir
Volume in volume 2: is
Directory of 2:

File Name Size Date

config 7132 11/11/94

bn.exe 2644489 01/25/95
install.bat 147222 01/31/95
ti.cfg 184 01/31/95
debug.al 12568 01/31/95

freboot.exe 173040 01/31/95
frediag.exe 230405 01/31/95

$

Figure 3-3. Sample Files Displayed by the Technician Interface

The files and display format may vary on your system.

3. Verify that the directory holds the Quick-Start installation files
listed in Table 3-1 or their equivalents.

Table 3-1.  Quick-Start Installation Files

Filename File Type

---.exe (example - bn.exe) See Table 3-2 for the bootable router
ace.out software image for your router.
config Configuration file

debug.al Alias file

install.bat Installation script file

ti.cfg Initial configuration file

Note: Other files may be in the directory.
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4. Verify that the directory holds the correct router software image for
your router (Table 3-2).

Table 3-2.  Version 8.10 Router Software Images

Router Router Software Runs On
Image
AFN (Flash) afn.exe Flash card
IN in.exe Flash card
ASN asn.exe Flash card
BLN bn.exe Flash card
BCN bn.exe Flash card
AN an.exe Flash Single
Inline Memory
Modules (SIMMs)
CN, FN, LN (VME) | ace.out Flash card

If your installation files or router software image are not available,
contact the Bay Networks Help Desk.

Booting the Router Without Configuration

Before running the Quick-Start installation script, you must initialize
the router without existing configuration by booting the router with

the ti.cfg file.
1. Boot the router using the ti.cfg file by entering the following
command:

boot <slot_number>:<image_file> <slot_number>:ti.cfg

where <slot_number> identifies where the volume resides on the
router and </mage_file> is the router software image for your router
(Table 3-2).
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Example:

boot 2:bn.exe 2:ti.cfg

Note: You also must boot the router with the #i.cfg file before running
the Quick-Start installation script if

a

The router is currently booted off a configuration file other
than ti.cfg.

You terminate the installation script.

You change the initial IP connector (port) that you use to
communicate with the Site Manager workstation.
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Running the Quick-Start Installation Script

After booting the router without configuration, you are ready to run
the Quick-Start installation script. Table 3-3 lists the commands you
use to run the script.

Table 3-3.  Quick-Start Installation Script Commands
To Do the . -
Following: Action: Details:
Accept adefault | Press Return. Your terminal displays default val-
value. ues in brackets; for example, [E21].
Repeat a step Press Control-c. | When prompted Terminate

(for example, if
you make a

script y/n?, type n. The Techni-
cian Interface returns to the begin-

mistake). ning of the step so you can re-enter
the information.

Quit out of the Press Control-c. | When prompted Terminate

Quick-Start script y/n?, typey. The Quick-

installation Start script terminates and returns

script. to the Technician Interface prompt.

Note: Reboot the router using the
ti.cfg file before rerunning the
Quick-Start installation script.

To run the script:

1. Change to the slot or drive where the router’s memory card or
volume resides.

NVFS Instructions:
Change to the slot by entering:

cd <slot number>:

Include the colon (:) after the slot number as part of the
command string.
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DOS Instructions:
Change to the drive by entering
cd A:

Include the colon (:) after the drive identifier A as the command
string.

2. Start the script by entering
run install

The Quick-Start installation script begins.

Version 1.91
Copyright 1993-1995

Figure 3-4. Beginning of the Quick-Start Installation

3. Enter the network information as you are prompted. Refer to your
Network Information Worksheet as you proceed through the script.

The script prompts you to identify the configuration information for
this initial IP interface, identify the IP address of the Site Manager
workstation, specify a TFTP default volume where you want
transactions to take place, and enable Telnet (optional).

Many steps suggest default values you should accept. Some steps
are optional for your network requirements.
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Note: If you terminate the installation script, reboot the router using
the ti.cfg file before you rerun the Quick-Start installation
script.

The script displays a summary of the newly configured IP interface
(Figure 3-5), and then prompts you to save the configuration to a
file.

Configuration Summary

Link Module: QE/F

Connector: 1

Slot: 2

Circuit Name: E21

IP address: 195.180.135.72
IP subnetwork mask: 255.255.255.000
Routing Protocol: RIP

Default Rt. Listen: No
TFTP Default Volume: 2:
TI TELNET: No

Press [RETURN] to continue:

Figure 3-5. Summary Information of a Quick-Start Installation

4. Save the configuration file as startup.cfg.

Save this initial IP configuration to a file to maintain a permanent
copy. If you do not save the configuration to a file, you will lose it
when you reboot the router.

5. Verify completion.

The router tests the IP interface configuration by “pinging” the Site
Manager workstation. If the ping is successful, the initial IP
interface is enabled and the script displays this message:

Quick-Start Installation Completed

The Technician Interface prompt appears.
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If the router cannot ping the Site Manager workstation:

)

a

Check the physical connections.

You may have entered an invalid IP address. Use the show ip
circuits script in the Technician Interface to make sure that the
physical interface is up and that the IP address is correct. To
learn how to implement scripts and for more information about
the show script, refer to Using Technician Interface Scripts.

Verify the IP address and subnetwork mask address of the Site
Manager PC or workstation.

If the workstation is on a different network, verify that routing
is working. Use the show ip routes script in the Technician
Interface to examine the routing table and verify that there is a
route or a default route to the network where the Site Manager
workstation is located. To learn how to implement scripts and
for more information about the show script, refer to Using
Technician Interface Scripts.

6. Don’t reboot the router after completing this procedure.

There’s no need to reboot after a successful installation. As you
proceed through the Quick-Start installation script, you are
dynamically configuring the interface. The configuration
information you enter takes effect immediately.

You can now exit the Technician Interface as described in the following
section.

Exiting the Technician Interface

If you want to assign a security password to the Technician Interface
interface before logging out of the Technician Interface, see Using
Technician Interface Software for instructions.

To exit the Technician Interface interface, enter logout at the prompt.

If you used an ASCII console to establish a Technician Interface
session, you can disconnect it from the router at this time if you wish.
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If you used terminal emulation to establish a Technician Interface
session, select File>Exit.

After you install Site Manager, you use the Technician Interface
primarily as a backup interface should Site Manager become
unavailable.
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Chapter 4
Installing the Site Manager Software

To install and start up the Site Manager software on a supported
hardware platform you need information on

o System hardware and software requirements
0 Loading the Site Manager software

0 Starting up the Site Manager application

To find this information, turn to the section in this chapter appropriate
to your hardware:

0 “Installing Site Manager on a SPARCstation”
0 “Installing Site Manager on an RS/6000”

o “Installing Site Manager on a PC”

0 “Installing Site Manager on an HP 9000”
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Installing Site Manager on a SPARCstation

To install Site Manager on a SPARCstation, you need to understand

)

o o o o o o

SPARCstation Site Manager system requirements

How to set up the SPARCstation

How to load Site Manager

How to set up Site Manager user accounts

How to verify the Site Manager installation

Site Manager and HP OpenView® implementation notes

How to start up Site Manager

SPARCstation System Requirements

The SPARCstation Site Manager 2.10 requires the following to run:

0

Sun® Microsystems Sun4 SPARCstation equipped with an
Ethernet, Token Ring, or FDDI network adapter

CD-ROM drive
1.44-MB 3.5-in. disk drive

Sun OpenWindows 3.0 or later, or MIT X11 Window System ™ 4.0
or later

SunOS® 4.1 or later, or Solaris® 2.3 or later

At least 16 MB of RAM,; at least 25 MB of free disk space; and at
least 32 MB of swap space

Setting Up the SPARCstation

Before you load the Site Manager software on your SPARCstation,
follow these steps:

1.

Log in to the SPARCstation as root.
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2. Edit the /etc/services system file (on each host device) to include
the following lines at the bottom of the file:

snmp 161/udp
snmp-trap 162/udp

You can use any available text editor to edit the file. The first line
associates the service name SNMP with UDP port number 161 on

this host device. The second line associates the service name
SNMP-trap with UDP port number 162.

3. Save /etc/services, and exit from the text editor.

4. Load the software from CD, as noted in the following section.

Loading the Software from CD

Load the Site Manager software on the SPARCstation as follows:
1. Insert the Wellfleet Site Manager CD into your CD-ROM drive.

2. Ifyou have not already created a CD-ROM mountpoint, log in as
root and create a root-level directory. For example, enter

mkdir /cdrom
3. Mount the CD-ROM drive as follows:
On SunOS, enter
mount -r -t hsfs /dev/<device> /cdrom
On Solaris, enter

mount -F hsfs -0 ro /dev/<device> /ecdrom

Note: If you use Solaris and you are running the vold daemon, the
CD-ROM will automatically be mounted as /edrom/
release_810_210rather than /cdrom.

4. Change to the CD-ROM mountpoint by entering
cd /cdrom/release_810_210
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6.

Run the script to load the Site Manager software by typing
./ INSTALL.SH
Type the command in all uppercase letters. The installation process

— Lists the directories that contain enough space to install Site
Manager. You can then specify which directory you want to use.

— Executes the Site Manager installation script,
WFSM_INSTALL.

When the installation is finished, your workstation displays the
message

Site Manager Installation Complete.

Press Control-d to exit the root account.

Proceed to the next section.

Setting Up Site Manager Users on a SPARCstation

Set up individual Site Manager users on the SPARCstation as follows:

1.
2.

Log in to the user’s account.

Create the directory in which to install the Site Manager’s image
builder application by entering

mkdir $HOME/.builder_dir
Edit the user’s account setup file as follows:

— If the user uses csh or clones, then add the following lines to
.cshre:

set path = ($path /usr/wi/bin)

setenv WF_SMPATH /usr/wf

setenv SMTERM X

setenv SM_CONFIGS <directory where config files are stored >
setenv BUILDER_DIR $HOME!/.builder_dir
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Note:

If the shell variable path is already set in some other line of the
.cshrc file, then add these new lines immediately after the last
set path line.

If the user uses the Bourne shell (sh) or clones, then add the
following lines to .profile:

PATH=$PATH:/usr/wf/bin
WF_SMPATH=/usr/wf

SMTERM=X

SM_CONFIGS=<dlirectory where config files are stored >
BUILDER_DIR=$HOME/builder_dir

export WF_SMPATH SMTERM SM_CONFIGS
BUILDER_DIR

4. Log out of the user’s account.

Repeat Steps 1 through 4 for each user who wants to run Site
Manager.

Verifying Site Manager Installation on a SPARCstation

Verify the Site Manager installation and environment as follows:

1. Log in to the user’s account.

2. Start up the X Windows system environment.

3. Verify the Site Manager installation by entering

wfchkinst

After installation is verified, the workstation displays the message

Installation is complete and correct!

4. Verify the Site Manager environment by entering

wfchkenv

After the environment is verified, the workstation displays the
message
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Your environment seems to have been set up correctly.

Repeat Steps 1 through 4 for each user that has Site Manager
installed.

Starting Up Site Manager on the SPARCstation

Start up the Site Manager application as follows:

1. Log in to a user account that has been set up for Site Manager
operation.

2. Start up the X Window environment.
3. Change to the directory where you want to store configuration files.

The following sample command changes to the directory
/ home / siteman/config_files:

cd /home/siteman/config files

4. Activate Site Manager by entering the following command, where
<router_IP_address > is the IP address of the router’s initial IP network
interface you configured in Chapter 3:

wfsm -a <router IP_address > &
A sample command is as follows:
wfsm -a 192.32.156.7 &

The Site Manager window appears (Figure 4-1). Proceed to the next
chapter.
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[® Wellfleet Site Manager
File Yiew Options Tools Administration Help
Connectionl[Statisticsl igggraps AI{ Events | f Files J

tions

Down

System Name/IP Address: 192,32, 18, 107
SNMP ID (Community) : public

"y

System Name:

L

Contact:

R

Location:

Description: »

MIB Version: <Y .YY

Model: Backbone Uoncentrator Node (BCN)
Power Supply 1: On Line

Power Supply 2: On Line

Power Supply 3: On Line

Power Supply 4: On Line

Fan: On Line

Temperature: Normal

Figure 4-1. Wellfleet Site Manager Window

Starting Site Manager from SunNet Manager
To start a Site Manager session on a platform running SunNet
Manager, follow these steps:

1. Open a view containing the icon of a router that you want to
configure using Site Manager.

2. Click on the icon of the router you want to configure.

3. From the Tools menu, choose Tools, then drag right and choose Site
Manager (Figure 4-2).
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The Site Manager window is displayed.

i El SunNet Manager Console: baynet ]
(File ) (view v) (Edit v) (Props...) (Requestsv) (Tools v) (Goto: V) o
192.168.7.2 =

l_—LF": Quick Dump B> | @
Send Request... P

192.1
SN-192.168.3.64

@ / Send Predefined D> PS
SN-192.168.1.0 Set Request >
Alarm Reports... ‘ v
(Tools Add to Node Name DB...
Glyph State RouterMan
@ Show Subviews |[(Site Manager D)

Properties... Telnet

Connect QJ)

Change Type... .66 SN-192.32.242.0

@ SN-192.168.T°T \\
-

SN-192.168.7.0

SN-192.168.2.64

SN-192.32.83.4

fo—
0 m KINLY 0
L, _J
U.3246

Figure 4-2. Starting a Site Manager Session from SunNet Manager
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OpenView Implementation Notes

Read this section if you plan on installing or are currently running the
HP OpenView application on your SPARCstation.

If you install OpenView after you install the Site Manager software,
follow these steps to integrate Site Manager with the OpenView
application:

1. Change to the /usr/wf directory.
2. Re-execute the Site Manager script by entering
./ WFSM_INSTALL

In the future, you must also follow these steps any time you reinstall
OpenView.

Starting Site Manager from OpenView

To start a Site Manager session from the IP Internet window menu bar
in OpenView, follow these steps:

1. Open a view containing the icon of the router that you want to
configure using Site Manager.

2. Click on the icon of the router you want to configure.

The IP Internet window opens (Figure 4-3).
3. Choose Site Manager from the Tools menu, as shown in Figure 4-3.

A list of options available from Site Manager appears.
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(=]

IP Internet

S

}file Edit View Locate Options Monitor Test

Tools | Administer

MIB Browser: SNMP...

Filter Editor...

MIB Application Builder: SNMP...

Graph Collected Data: SNMP >
Data Collection & Thresholds: SNMP...

Help l

Site Manager >

[Site Manager...

1

SynOptics Application
Failing Resource Display...
Mail...

Print...

Configuration (dynamic)...
Statistics Manager...
Trap Monitor...

Remote Files Manager...
Event Files...

Update Symbols...

—T

U.28442

Figure 4-3. Starting a Site Manager Session from OpenView
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Installing Site Manager on an RS/6000

To install Site Manager on an RS/6000 workstation, you need to
understand

g QO a o a 0

RS/6000 Site Manager system requirements

How to load Site Manager

How to set up Site Manager user accounts

How to verify the Site Manager installation

Site Manager and NetView®/6000 implementation notes

How to start up Site Manager

RS/6000 System Requirements

The RS/6000 Site Manager 2.10 requires the following to run:

a

IBM® RISC System/6000 equipped with either an IBM Ethernet
High-Performance network adapter or an IBM Token Ring
High-Performance network adapter

IBM AIX ® 3.2.4 or later releases
X11 Release 5

Note: When ordering an IBM RS/6000 or an upgrade of the IBM AIX,

)

request X11 Release 5. Site Manager does not run with earlier
versions of X11.

Motif ® 1.1.4 or later

Note: NetView/6000 versions 2.1 and earlier require Motif 1.1.4.

However, X11 Release 5 typically ships with Motif 1.2 as the
default. Therefore, if you are using NetView/6000 Version 2.1,
and you are running a later version of Motif (such as 1.2), then
you must use the instructions that follow to switch the
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currently installed version of Motif to Motif 1.1.4. This allows
Site Manager and NetView/6000 Version 2.1 to operate.

CD-ROM drive
A minimum of 16 MB of RAM
A minimum of 20 MB of free disk space

a QO o O

A minimum of 64 MB of swap space (96 MB of swap space if used
with the NetView/6000 application)

You switch the currently installed version of Motif (1.2 or later) to
Motif 1.1.4 as follows:

1. Enter the following AIX commands:
lusr/lpp/X11rte/set_symlinks.Motifl.1
lasr/lpp/X11dev/set_symlinks.Motifl.1

2. Restart NetView/6000.

If you need to switch back to Motif 1.2, follow these instructions:

1. Enter the following AIX commands:
lusr/lpp/X11rte/set_symlinks.Motif1.2
/usr/lpp/X11dev/set_symlinks.Motifl.2

2. Restart NetView/6000.

Note: The services (network services) directory supplied with the
operating system should be complete. If the snmp or snmp-trap
files are missing, contact your system administrator.

Loading the Software from CD

Load the Site Manager software on the RS/6000 as follows:
1. Insert the Wellfleet Site Manager CD into your CD-ROM drive.
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6.

If you have not already created a CD-ROM mountpoint, log in as
root and create a root-level directory. For example, enter

mkdir /cdrom

To mount the CD-ROM drive, enter

mount -o ro -v cdrfs /dev/<device> /cdrom

Change to the CD-ROM mountpoint by entering

cd /cdrom

Run the script to load the Site Manager software by typing

./ install.sh

Type the command in all lowercase letters. The installation process

— Lists the directories that contain enough space to install Site
Manager. You can then specify which directory you want to use.

— Executes the Site Manager installation script,
WFSM _INSTALL.

When the installation is finished, your workstation displays the
message

Site Manager Installation Complete.

Press Control-d to exit the root account.

Proceed to the next section.

Setting Up Site Manager Users on an RS/6000

Set up individual Site Manager users on the RS/6000 as follows:

1.
2.

3.

Log in to the user’s account.

Create the directory for the Site Manager’s image builder
application by entering

mkdir $HOME/.builder_dir

Edit the user’s account setup file as follows:
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Note:

If the user uses csh or clones, then add the following lines to
.cshre:

set path = ($path /usr/wi/bin)

setenv WF_SMPATH /usr/wf

setenv SMTERM X

setenv SM_CONFIGS <directory where config files are stored >
setenv BUILDER_DIR $HOME/.builder_dir

If the shell variable path is already set in some other line of the
.cshrc file, then add these new lines immediately after the last
set path line.

If the user uses the Bourne shell (sh) or clones, then add the
following lines to .profile:

PATH=$PATH:/usr/wf/bin

WF_SMPATH=/usr/wf

SMTERM=X

SM_CONFIGS=<directory where config files are stored >
BUILDER_DIR=$HOME/builder_dir

export WF_SMPATH SMTERM SM_CONFIGS
BUILDER_DIR

4. Log out of the user’s account.

Repeat Steps 1 through 4 for each user who wants to run Site
Manager.

Verifying Site Manager Installation on an RS/6000

Verify the Site Manager installation and environment as follows:

1. Log in to the user’s account.

2. Start up the X Windows environment.

3. Verify the Site Manager installation by entering
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wfchkinst
After installation is verified, the workstation displays the message
Installation is complete and correct!
4. Verify the Site Manager environment by entering
wfchkenv

After the environment is verified, the workstation displays the
message

Your environment seems to have been set up correctly.

Repeat Steps 1 through 4 for each user that has Site Manager
installed.

Starting Up Site Manager on an RS/6000

Start up the Site Manager application as follows:

1. Log in to a user account that has been set up for Site Manager
operation.

2. Start up the X Window environment.
3. Change to a directory where you want to store configuration files.

The following sample command changes to the directory
/ home / siteman / config_files:

cd /home/siteman/config _files

4. Activate Site Manager by entering the following command, where
<router IP_address> is the IP address of the router’s initial IP network
interface you configured in Chapter 3:

wfsm -a <router_IP_address> &
A sample command is as follows:
o wfsm -a 192.32.156.7 &

The Site Manager window appears. After you successfully install
and start up Site Manager, proceed to the next chapter.

4-15



Installing Site Manager on an RS/6000

NetView/6000 Implementation Notes

Read this section if you plan on installing or are currently running the
NetView/6000 application on your RS/6000 workstation.

If you install NetView/6000 on your RS/6000 after you install the Site
Manager software, follow these steps to integrate Site Manager with
the NetView/6000 application:

1. Change to the /usr/wf directory.

2. Re-execute the Site Manager script by entering
./ WFSM_INSTALL

In the future, you must also follow these steps any time you reinstall
NetView/6000.

Starting Site Manager from NetView

To start a Site Manager session from the IP Internet window menu bar
in NetView, follow these steps:

1. Open a view containing the icon of the router that you want to
configure using Site Manager.

2. Click on the icon of the router you want to configure.
The IP Internet window opens (Figure 4-4).
3. Choose Site Manager from the Tools menu shown in Figure 4-4.

A list of options available from Site Manager appears.
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=

IP Internet

:l‘

'file Edit View Locate Options Monitor Test

Tools Administer

MIB Browser: SNMP...
Graph Collected Data: SNMP

Filter Editor...

MIB Application Builder: SNMP...

Data Collection & Thresholds: SNMP...

Help |

>

Site Manager >

1
Site Manager...

SynOptics Application
Failing Resource Display...
Mail...

Print...

Figure 4-4. Starting a Site Manager

Configuration (dynamic)...
Statistics Manager...
Trap Monitor...

Remote Files Manager...
Event Files...

Update Symbols...

Session from NetView

U.2844.2
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Installing Site Manager on a PC

To install Site Manager on a PC, you need to understand

a

a o o o

PC Site Manager system requirements

How to install and configure the networking software
How to test Distinct TCP/IP

How to load Site Manager

How to start Site Manager

System Requirements

The PC Site Manager 2.10 requires the following to run:

a

o o o a

A 386 PC with at least 4 MB of RAM and at least 16 MB of free disk
space. (We recommend using a 486 PC with at least 8 MB of RAM.)

CD-ROM drive — if you intend to load the Site Manager software
from CD rather than disks.

A VGA monitor. (We recommend you use a SuperVGA monitor.)
DOS 5.0® or later.
Microsoft® Windows 3.1 or later.

A network interface card (NIC) based on Packet, Network Driver
Interface Specification (NDIS), or Novell® Open Data Link
Interface (ODI).

Any TCP/IP stack that Windows Sockets supports. Such stacks
include NetManage Chameleon, Novell’s LAN Workplace, and FTP
Software’s PC/TCP for Windows.

Note: PC Site Manager comes with the Distinct TCP/IP™ for

Microsoft Windows software, Version 3.21. This software
includes Windows Sockets. If you use a different TCP/IP stack,
you do not need to install Distinct.
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Refer to the appropriate documentation to install the prerequisite
hardware and software. The sections that follow provide guidelines for
using the Distinct TCP/IP for Microsoft Windows manual to install
and configure Distinct TCP/IP. If you do not need to install Distinct,
proceed to the section “Loading the Site Manager Software on a PC”
later in this chapter.

Installing and Configuring the Networking Software

Distinct TCP/IP for Microsoft Windows, a Distinct® Corporation
application, is supplied with the PC Site Manager. Distinct provides an
interface between Site Manager and the TCP/IP network.

Only the Distinct features required for Site Manager — TFTP and
Ping — are operational.

With Version 8.10/2.10, the Distinct software is distributed on the Site
Manager CD. To load Distinct from CD, use the operating system
commands for your hardware platform to

Insert the Wellfleet Site Manager CD into your CD-ROM drive.
Double-click on the File Manager icon.

Click on the CD-ROM drive icon in the File Manager window.
Double-click on the Distinct icon.

Double-click on the setup.exe utility to start the program.

Use Chapter 1, “Distinct TCP/IP Overview,” and Chapter 2,
“Network Configuration,” of the Distinct TCP/IP for Microsoft
Windows manual to configure the Distinct TCP/IP software.

& o WD

7. Provide the serial number, key code, network-interface card, and
driver information as required by the software. Table 4-1 shows the
serial numbers and corresponding key codes you can use. Table 4-2
shows the packet drivers and NDIS drivers the Distinct TCP/IP

installation process supports.

The use of Distinct’s TCP/IP Run Time software is subject to the
Distinct Software License Agreement. Each Distinct License

4-19



Installing Site Manager on a PC

Agreement allows you to install Distinct on up to 15 PCs per IP subnet.
Follow the same installation procedure for each PC.

Note: We recommend installing and configuring Distinct’s
TCP/IP Run Time software successfully on one PC before you
attempt to install it on additional systems.

You must initialize the software at installation time by entering a
serial number and a key code. There is a serial number associated with
each copy of the software licensed. You must use a different serial
number for each computer on which you install the software.

Table 4-1.  Distinct Serial Numbers and Key Codes

Serial No. Key Code

ROOWELLFO00 F6-73-F2
ROOWELLFO1 00-53-46

ROOWELLF02 EA-B3-00
ROOWELLF03 F4-93-BC
ROOWELLF04 9E-F3-D5
ROOWELLFO05 88-D3-1E
ROOWELLF06 92-33-F1

ROOWELLFO07 BC-13-60
ROOWELLFO08 A6-73-20
ROOWELLF09 B0-53-E6
ROOWELLF10 FF-53-5C
ROOWELLF11 09-33-43

ROOWELLF12 F3-93-73

ROOWELLF13 FD-73-37
ROOWELLF14 A7-D3-17
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Note: The installation process requires you to know the type of
network-interface card and driver your PC is using. If your PC
uses the IBM Token Ring Adapter driver, you must install the
IBM LAN Support driver package before installing Site

Manager.

If the driver for your network card is not in this table, refer to the
section “Configuring the System for Your Own Ethernet or Token Ring
Driver” in Chapter 2 of the Distinct TCP/IP for Microsoft Windows
manual. We recommend selecting the “NDIS Driver over Ethernet”
procedure within that section if you have a laptop PC and are using a
Xircom Pocket Ethernet Adapter to fulfill the NIC system requirement.
Go to the next section of this manual and test the Distinct TCP/IP
configuration before installing Site Manager.

Table 4-2.  Distinct-Supported Packet and NDIS Drivers

Driver Type NDIS Support Packet Support
3Com® 3C501 Yes” Yes”
3Com 3C503 Yes” Yes”
3Com 3C507 Yes” Yes”
3Com 3C523 Yes Yes
3Com 3C509 Yes Yes
Cabletron”™ E11 (8 bit) Yes No
Cabletron E21 (16 bit) Yes No
Digital” Equipment DEPCA"™ Yes Yes
HP LAN Adapter Yes Yes
IBM Token Ring Adapter Yes Yes®
Intel” EtherExpress Yes Yes

*Drivers that have been tested by Bay Networks.
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Table 4-2.  Distinct-Supported Packet and NDIS Drivers (continued)

Driver Type NDIS Support Packet Support
Interlan® N15210 Yes Yes
Interlan N16510 Yes Yes
Novell NE1000 No Yes
Novell NE2000 No Yes
SMC/Western Digital~ Elite 16 (16 bit) | Yes Yes
SMC/Western Digital Elite Yes Yes
Ethercard Plus (8 bit)

Tiara LAN Card/E AT Yes Yes
Ungermann Bass” NIC/PC Yes Yes
Xircom Pocket Yes” No
*Drivers that have been tested by Bay Networks.

Note: The Distinct TCP/IP for Microsoft Windows manual describes
how to use all Distinct features, including those not provided
with Site Manager (for example, outbound Telnet or FTP
capability). These features are available directly from Distinct.
Contact Distinct Corporation for additional information at 408-
741-0781.

Testing Distinct TCP/IP

Use the Distinct ping function to send an echo request to the router
after installing and configuring Distinct TCP/IP. This procedure tests
the functionality of your network and your Distinct configuration.

Perform the test as follows:

1. From the Program Manager window, double-click on the Distinct
icon.
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2. Double-click on the Ping icon.

The Distinct TCP/IP Ping window appears.

Select Host in the menu bar.

Enter the name or address of the host in the Host box.
Click on the Select button.

o ook

Select the Start option in the menu bar.

The display indicates the number of requests transmitted and
replies received. If both are increasing, your network and your
Distinct configuration are functional.

7. Select the Stop option in the menu bar to terminate the test.
The Distinct TCP/IP Ping window appears.

8. Select Exit in the menu bar.

Loading the Site Manager Software on a PC

You must install your Windows Sockets-supported TCP/IP stack or the
Distinct TCP/IP application before you load the Site Manager software.
Refer to the previous section for guidelines on installing Distinct.

Site Manager software is available on disks and CD. The following
section describes the installation procedure for both types of media.

Loading the Software
1. Enter the following command to start up Windows:

win
2. 'To install Site Manager, follow these steps for disks or CDs:

From Disks:
a. Insert the PC Site Manager disk 1 into the disk drive.

b. Select File=®Run.
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c. Enter the following in the Command Line box to install the Site
Manager software:

<drive>:\setup

where <drive> specifies the drive (for example, A or B) in which
you inserted the PC Site Manager disk 1.

Install the remaining disks as you are prompted.
From CDs:
a. Insert the Wellfleet Site Manager CD into your CD-ROM drive.
b. Double-click on the File Manager icon.
c. Click on the CD-ROM drive icon in the File Manager window.
d. Double-click on the ms_win directory.
e. Double-click on the setup.exe utility.

The installation process prompts you for the directory in which you
want to install Site Manager.

Enter the directory in which to install Site Manager, or accept the
default, c:\wf.

The Site Manager files are installed in the chosen directory. When
the installation completes, the following prompt appears:

Create windows program group/items automatically?

To allow Site Manager to automatically create a windows group,
click on Yes. If you want to manually create a windows group, click
on No.

If you allow Site Manager to automatically create a windows group,
the following prompt appears:

Do you want to start Site Manager now?
Select Yes to start Site Manager. Select No to return to Windows.

If you chose to manually create a windows group, first refer to the
section “Creating a Windows Group.” Then proceed to the section
“Starting Up Site Manager on the PC.”
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Creating a Windows Group

You need to perform the steps in this section only if you chose (during
the procedure to load the Site Manager software) to manually create a
windows program group.

Create a windows group for the Site Manager executable software as
follows:

1.

Enter the following command after the DOS prompt to start
Windows:

win
Select File>New.
The New Program Object window appears.
Select the Program Group option and click on OK.
The Program Group Properties window appears.
a. Enter Site Manager in the Description box.
b. Enter wf in the Group File box.
c. Click on OK.

Select File>New to create an item for wfsm (Wellfleet Site
Manager).

Click on the radio button next to the Program Item option and click
on OK.

a. Enter PC/Site Manager in the Description box.
b. Enter c:\wf\wfsm.exe in the Command box.

c. Enter e:\wf\config in the Working Directory box.
d. Click on OK.

Select File=>Exit Windows and click on OK at the confirmation
prompt.
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Adding a Well-Known Service for TFTP

Add a well-known service to the services file for TFTP as follows:

1. Change to the directory where the services file resides. Some
protocol stacks store the services file in the same directory as the
protocol software. For Distinct, the services file resides in the etc
directory, so you would type

cd c:\etc
2. Enter the following command to edit the services file:
edit services
The services file appears.
3. Scroll down until you see the following lines:

domain 53/tcp
hostnames 101/tcp

4. Insert the following lines between the two lines shown in the
previous step:

tftp 69/udp
snmp 161/udp
snmp-trap 162/udp
The lines should appear as follows:
domain 53/tcp
tftp 69/udp
snmp 161/udp
snmp-trap 162/udp
hostnames 101/tcp

5. Press Alt-f to display the File menu, type x to exit, and type y to
save the changes.

Note: All TCP/IP stacks use the etc/services stack. For example,
Chameleon uses \netmanag\services.
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Booting the PC

Boot the PC to load the TCP/IP stack and set up the environment
variables. To boot the PC, press Control-Alt-Delete simultaneously.

Now refer to the next section to start up Site Manager.

Starting Up Site Manager on the PC

Start up the Site Manager application as follows:

1.

Make sure that Windows is up. To start Windows, enter the
following command after the DOS prompt:

win
Select the Site Manager program group.
Double-click on the PC/Site Manager icon.
The Site Manager window appears.

After you have successfully installed and started up Site Manager,
proceed to the next chapter on creating a pilot configuration.

Installing Site Manager on an HP 9000

If you are installing Site Manager on an HP 9000 workstation, you
need to understand

o o o o o a

HP 9000 Site Manager system requirements

How to load Site Manager

How to set up Site Manager user accounts

How to verify the Site Manager installation

Site Manager and HP OpenView implementation notes

How to start up Site Manager
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HP 9000 System Requirements

The HP 9000 Site Manager 2.10 requires the following to run:

o HP Precision Architecture System (HP 9000/7xx or
HP 9000/8xx) equipped with an Ethernet network adapter or a
Token Ring network adapter

HP-UX 9.01 or later releases

X11 Release 5

Motif 1.2

CD-ROM drive

A minimum of 16 MB of RAM

A minimum of 30 MB of free disk space

o o o o o o o

A minimum of 32 MB of swap space

Note: The services (network services) directory supplied with the
operating system should be complete. If the snmp or snmp-trap
files are missing, contact your system administrator.

Loading the Software from CD

Load the Site Manager software on the HP 9000 as follows:
1. Insert the Wellfleet Site Manager CD into your CD_ROM drive.

2. If you have not already created a CD-ROM mountpoint, log in as
root and create a root-level directory. For example, enter

mkdir /cdrom

3. Mount the CD-ROM drive by entering
mount -r /dev/<device> /lecdrom

4. Change to the CD-ROM mountpoint by entering
cd /cdrom

5. Run the script to load the Site Manager software by typing
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6.

./ INSTALL.SH\;1
Type the command in all uppercase letters.
The installation process

— Lists the directories that contain enough space to install Site
Manager. You can then specify which directory you want to use.

— Executes the Site Manager installation script,
WFSM_INSTALL.

When the installation is finished, your workstation displays the
message

Site Manager Installation Complete.

Press Control-d to exit the root account.

Proceed to the next section.

Setting Up Site Manager Users on an HP 9000

Set up individual Site Manager users on the HP 9000 as follows:

1.
2.

Log in to the user’s account.

Create the directory for the Site Manager’s image builder
application by entering

mkdir $HOME/.builder_dir
Edit the user’s account setup file as follows:

— If the user uses csh or clones, then add the following lines to
.cshre:

set path = ($path /usr/wf/bin)

setenv WF_SMPATH /usr/wf

setenv SMTERM X

setenv SM_CONFIGS <directory where config files are stored >
setenv BUILDER DIR $HOME/builder dir
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Note: If the shell variable path is already set in some other line of the
.cshre file, then add these new lines immediately after the last
set path line.

— If the user uses the Bourne shell (sh) or clones, then add the
following lines to .profile:

PATH=$PATH:/usr/wf/bin

WF_SMPATH=/usr/wf

SMTERM=X

SM_CONFIGS=<directory where config files are stored >
BUILDER_DIR=$HOME/builder_dir

export WF_SMPATH SMTERM SM_CONFIGS
BUILDER_DIR

4. Log out of the user’s account.

Repeat Steps 1 through 4 for each user who wants to run the Site
Manager application.

Verifying Site Manager Installation on an HP 9000

Verify the Site Manager installation and environment as follows:
1. Log in to the user’s account.

2. Ifit is not already started, start up the HP VUE or X Window
environment.

3. Verify the Site Manager installation by entering
wfchkinst

After installation is verified, the workstation displays the message

Installation is complete and correct!
4. Verify the Site Manager environment by entering
wfchkenv

After the environment is verified, the workstation displays the
message
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Your environment seems to have been set up correctly.

Repeat Steps 1 through 4 for each user that has Site Manager
installed.

Starting Up Site Manager on an HP 9000

Start up the Site Manager application as follows:

1.

Log in to a user account that has been set up for Site Manager
operation.

If it is not already started, start up the HP VUE or X Window
environment.

Change to a directory in which you want to store configuration files.

The following command changes to the directory
/ home/siteman / config_files:

cd /home/siteman/config files

Activate Site Manager by entering the following command, where
<router IP_address> is the IP address of the router’s initial IP network
interface, which you configured in Chapter 3:

wism -a <router_IP_address > &
The following is a sample command:
wfsm -a 192.32.156.7 &

The Site Manager window appears on the screen.

5. Proceed to the next chapter.

OpenView Implementation Notes

Read this section if you plan on installing, or are currently running,
the HP OpenView application on your HP 9000 workstation.

If you install OpenView after you install the Site Manager software,
follow these steps to integrate Site Manager with the OpenView
application:
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1. Change to the /usr/wf directory.
2. Reexecute the Site Manager script by entering
./ WFSM_INSTALL

In the future, you must also follow these steps any time you reinstall
OpenView.

Starting Site Manager from OpenView

To start a Site Manager session from the IP Internet window menu bar
in OpenView, follow these steps:

1. Open a view containing the icon of the router that you want to
configure using Site Manager.

2. Click on the icon of the router you want to configure.

The IP Internet window opens (Figure 4-5).
3. Choose Site Manager from the Tools menu, as shown in Figure 4-5.

A list of options available from Site Manager appears.

—
IFEI IP Internet R
Eile Edit View Locate Options Monitor Test 1@] Administer Help I
MIB Application Builder: SNMP...
MIB Browser: SNMP...
Graph Collected Data: SNMP >
Data Collection & Thresholds: SNMP...
Filter Editor...
|Site Manager > |Site Manager... I
SynOptics Application Configuration (dynamic)...
Failing Resource Display...| Statistics Manager...
Mail... Trap Monitor...
Print... Remote Files Manager...
Event Files...
Update Symbols...

U.28442

Figure 4-5. Starting a Site Manager Session from OpenView
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Creating a Pilot Configuration File

Use Site Manager to create a pilot configuration for the router, as
described under the following topics:

a

a Qo o o Qo Q

Overview of creating a pilot configuration file
Sample pilot configuration

Creating a configuration file

Rebooting the router with the pilot configuration file
Enhancing the pilot configuration file

Restricting read/write access to the router

Setting the router to secure mode
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Summary of Tasks

To create a pilot configuration, you use Site Manager to
1. Establish an SNMP connection with the router.
2. Start the Configuration Manager tool in remote mode.

Site Manager retrieves the router’s hardware and displays its
configuration in a window on your screen.

3. Configure a pilot IP interface for the router.

In Chapter 3, you used the Technician Interface to locally configure
the router’s initial IP interface. In this chapter, you use Site
Manager to remotely configure a second IP interface — the pilot IP
interface.

4. Save the pilot interface configuration to a configuration file on
the router.

5. Implement the pilot configuration by rebooting the router.

Note: Because you are mainly interested in testing the Site Manager-
to-router network connection, accept all Site Manager default
parameter settings when you are creating this pilot
configuration file. Later, you can edit the parameters to meet
your specific network needs (see Configuring Wellfleet Routers
for instructions).

Sample Pilot Configuration

In Chapter 3, you used the Technician Interface to configure the initial
IP interface (depicted as Circuit E21 with IP Address 192.32.156.7 in
Figure ). In this chapter, you will use Site Manager to configure Circuit
E22 and create the pilot IP interface. The router in Figure contains a
single memory card (volume), located in Slot 2.
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Note: All examples in this chapter reflect the sample pilot
configuration shown in Figure 5-1.

|
IP Address =
192.32.10.12

N

Corporate IP network Site Manager

1
IP Address =
IP Address = 158.10.2.204
192.32.156.7
| Interface E22 : :
ﬁ § IP Configuration Information IP workstation

= = . IP Address = 158.10.2.204 .
= . Subnet Mask = 255.255.255.0 I
Router ' Broadcast Address = 158.10.2.255 |

Figure 5-1. Sample Pilot Configuration
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Creating a Configuration File

If you followed the instructions in Chapter 4, the Site Manager window
should now appear on the screen (Figure 5-2).

[® Wellfleet Site Manager
File View Options Tools Administration Help
IConnection ZStatisticsl i Traps | g Events | E Files l

Well-Known Connectiong
192, 52, 18, 107 1p
192,32,18,103  Down

System Name/IP Address: 192,32, 18,107
SNMP ID (Community) : public

System Name:

»»

Contact:

nn

Location:
Description: »

MIB Version: <Y.YY

Model: Backbone Uoncentrator Node (BCN)
Power Supply 1: On Line

Power Supply 2: On Line

Power Supply 3: On Line

Power Supply 4: On Line

Fan: On Line

Temperature: Normal

Figure 5-2. Wellfleet Site Manager Window

Note: The screens displayed in this chapter reflect Site Manager as it
appears on a SPARCstation. The screens vary slightly on an
RS/6000, HP 9000, or PC.
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Specifying the Router

To begin, specify the router you are configuring as follows:

1. Select Options->Router Connections.

Site Manager displays the SNMP Options window

(Figure 5-3).

[@] Router Connection Options

Node Name/IP Address

Identity (Community)

Timeout (seconds)

Retries (per request)

92,32, 14,39 N

16
-

3
-

192.32.156.7
Cancel

Figure 5-3. IP Address of the Router’s Network Interface

Specify the

IP address of the
router’s network
interface to the
Site Manager
workstation.

2. Enter the IP address of the router’s network interface to Site
Manager in dotted decimal notation.

The IP address you enter here is the address you assigned to the
router’s initial network interface (using the Technician Interface).
Because you have not yet configured any other router interfaces,
the router should have only one IP address.

For now, accept the default values for the other SNMP parameters.

3. Click on the OK button.

Site Manager establishes a connection with the specified router.
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Using Remote Mode to Retrieve the Router’s Hardware Configuration

Next, retrieve the router’s hardware configuration as follows:
1. Select Tools=>Configuration Manager->Remote File.

The Edit Remote Configuration File window appears (Figure 5-4).
Site Manager retrieves the file information from the router and
displays it in this window. The Volume button on the right side of
the screen specifies the location of the volume on which the
configuration file will be stored.

[®] Edit Remote Configuration File FT]

Edit Configuration File

Cancel
Enter file name: Yolume: NVFS only:
Click on this
I startup, cfg ; <—— button to access
a different
Select the Directory: volume.
configuration boot, exe 4
filename you
created in >
Chapter 3.

Figure 5-4. Naming the Configuration File
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In an NVFS system, the volume is the number of the slot
containing the memory card. To access other memory cards
residing in different slots, follow these steps:

a.

Select the button showing the current volume and hold the
mouse button down.

A menu displays the NVFS volumes.

Select the slot of the volume that you want and release the
mouse button.

The volume you selected is displayed.

In a DOS file system, the volume is always A.

2. Select the startup.cfg file, and then click on the Open button.

If you named the initial configuration file you created in Chapter 3
something other than startup.cfg, then select that file and click on
the Open button.

Site Manager displays a graphic representation of the specified
router’s hardware configuration in the Configuration Manager window
(see Figure 5-5). The router model determines the number of slots in
the window. Figure 5-5 shows five slots because the example is for an
LN. The window numbers each slot, and identifies the module in each
slot and the type and position of the connectors (or ports) on the
module.

Note:

The position of the slot numbers in the Configuration Manager
window corresponds to the position of the slots in the router.

For the ASN, the module numbering in the Configuration
Manager window represents the module numbering on the
router. Remember, in the ASN, modules are the locations where
the net modules reside.
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[® Configuration Manager
File Options Platform Circuits Protocols Dialup Window Help

Configuration Mode: local
SNMP Agent: LOCAL FILE |
File Name: /extra/smgr/Jjohn/ctf
Model: Backbone Link Node %BL[\D
MIB Version: %8, 10

Color Key: Used Unused

Slot Description Connectors

5 t 5406 Dual Ethernet | BNEUENM | wouE | NONE | B

4 15720 Single Sync, oingle Toke| [ COMI | [ NONE || NONE | { TOKENI |
3 f Eapty Slot | FRORE ] NONE | [ NONE | NONE |
2 ; Eupty Slot | F7HONE ] NONE ] NONE || NONE |
1 |

System Resource Module | JEEUENHD

Figure 5-5. Sample Configuration Manager Window
Note that before you configure the pilot IP interface, you may want to
specify system-record information for the router:

1. Select the File>Edit System Record option to display the Edit
System Description Parameters window (Figure 5-6).

2. Enter the system-record information for the router.
3. Click on the OK button.

The Edit System Description Parameters window closes and the
Configuration Manager window becomes the active window.

In the future, every time Site Manager communicates with the router,
the Site Manager window displays the information you specified.
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@] Edit System Description Parameters
Configuration Mode: remote 0K ] Ent t
nter system
SNMP Agent: 192,32, 156, 7 informaion
System Name |LN /
Svstem Contact Joe Network g
System Location Boston

Figure 5-6. Sample Edit System Description Parameters Window

Configuring the Pilot IP Interface

Next, configure a pilot IP interface for the router by
0 Selecting a connector (port) on the router
0 Naming and saving the circuit that interfaces with the connector

0 Enabling the circuit with the IP routing protocol
The steps that follow guide you through this process.

Beginning from the Configuration Manager window (Figure 5-5),
configure the pilot interface as follows:

1. Select the Circuits=>Add Circuit option.

The Add Circuit window appears (Figure 5-7). This window
displays the connectors for each link module or net module
installed in the router. The router model determines the number of
slots (or in the case of the ASN, the number of modules) shown in
the window. Figure 5-7 shows five slots for an LN.
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[® Add Circuit
Configuration Mode: remote
SMMP Agent:  192.32.156.7
Circuit Name: |E22 Color Key:
) . Available
Select lines from available connectors: Selected
Slot, Connectors
5 £ NONE 71 NONE 1 NONE £ NONE
4 £ NONE £ NONE {1 NONE {1 NONE
3 £1 XCVR4 {1 XCVR3 {1 XCVR2 {1 XCVRL
2 £100M1 £ com2 {1 XCVR1
1 £ CONSOLE
Cancel

Figure 5-7. Sample Add Circuit Window

2. Click on one of the available connectors.

After you click on a connector, Site Manager names the circuit that

interfaces with this connector in the Circuit Name box. The default
. circuit name identifies the type of circuit and the location of the

connector (Figure 5-8). The default types are as follows:

E = Ethernet, E1 = E1, F = FDDI, O = Token Ring,

S = Synchronous, T1 = T1, and H = HSSI.

Slot (or ASN module)
where connector resides

Connector position on link module or
net module

Type of circuit
(E= Ethernet)

Figure 5-8. Site Manager Default Circuit Name
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Note: We recommend that you follow the default circuit-naming
conventions, so that circuit types and locations are represented
consistently.

If you choose not to follow the conventions, enter a circuit name.
Circuit names have a 15-character limit and must consist of
alphabetical, numeric, underline, and slash characters. Do not
enter spaces in circuit names. Circuit names are case-sensitive.

3. Click on the OK button to save the circuit.
You must save each circuit after you associate it with a connector.

If the link module or net module has hardware filters, the following
message appears: Do you want to enable Hardware Filters on
this circuit? Click on the OK button to enable hardware filters.
Otherwise, click on the Cancel button.

After you save the circuit, Site Manager displays the Select
Protocols window (Figure 5-9). You enable the circuit with bridging
and routing protocols from this window.

Note: The Select Protocols window differs slightly, depending on the
circuit type. If appropriate, you may be prompted to select a
WAN protocol. See Configuring Wellfleet Routers for more
information.
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[®] Select Protocols

Protocol Interfaces

{1 Bridge

1 Spanning Tree
P <4 Enable IP on this circuit.
1  RIP

EGP

BGP

OSPF
Reverse ARP
£ BOOTP

{1 Decnet IV

1 Vines

O IPK

{1 RIP(IPX)

0 2N

£ RIP(ANS)

{1 AppleTalk

{1 Source Routing
{1031

[ O

Ok | iCancel|

Figure 5-9. Sample Select Protocols Window

4. Select the IP option to enable IP routing on this circuit; then click
on the OK button.

5. Specify the information for the IP interface, as shown in the IP
Configuration window (Figure 5-10), and then click on the OK
button.
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- Help...

(@] IP CONFIGURATION ]
[ Cancel | Erter the
Configuration Mode: remote IP circuit
. : information
SNMP Agent: 192,32, 156,7 here.

/

TP &ddress (B8, 10, 2. 204
Subnet Mask 255, 255, 256. ( 1
Transmit Beast Addr | 158. 10, 2 255 &

Figure 5-10. IP Configuration Window

Once you have defined the IP interface, the Configuration Manager
window appears. The connector box is highlighted to indicate that the
circuit has been configured.

Later, when you create a complete configuration file for the router, you
repeat Steps 1 through 5 until all circuits on the router are configured.
This procedure is explained in the Configuring Wellfleet Routers guide.
For now, proceed to the next section.
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Saving the Pilot Configuration File

After you have configured the pilot IP interface for the router, save the
configuration to a file on the router.

Note: Site Manager does not create a configuration file until you save
the configuration information you specified.

To save the configuration to a file, begin at the Configuration Manager
window and proceed as follows:
1. Select the File>Save As option.

The Save Configuration File window appears (Figure 5-11). This
window displays the name startup.cfg —which is the file you
retrieved earlier in the procedure.

[®] Save Configuration File ET]

Save Configuration File
Replace the filename
startup.cly

with the filename :
piotcly ———> l pilot, cfell }

Enter file name: Volume:

Cancel

Figure 5-11. Save Configuration File Window

2. Delete the text displayed in the Enter file name box.
3. Enter the name pilot.cfg, then click on the Save button.

Site Manager generates a configuration file, transfers the file to the
router (via TFTP), and saves it to the router’s file system with the
name pilot.cfg. Site Manager stores the file remotely on the router,
because Site Manager is operating in remote mode.
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4. Click on the OK button when the File Saved! pop-up window
appears.

5. Select the File->Exit option to exit the Configuration Manager
window.

6. Click on OK at the confirmation prompt.
You are returned to the Site Manager window.

Now, to implement the configuration, reboot the router as described in
the next section.

Rebooting the Router with the Pilot Configuration File

After you save the pilot configuration file to the router, implement the
configuration by rebooting the router.

To reboot the router, begin from the Site Manager window shown in
Figure 5-2 and proceed as follows:

1. Select the Administration->Boot Router option.

The Boot Router window appears (Figure 5-12). The default volume
is displayed next to the boot image file (example: bn.exe) and
configuration file (config). The default volume is the first available
NVFS (indicated by slot number) or it is the DOS file system
(indicated by the diskette drive designator A).
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[®] Boot Router
Cancel

Boot Image: | Ace, out f
Configuration: Ipilot. cfg !

Click here to - — ?

select the volume___—
to boot from. |
Enter the name of the pilot configuration here.

Figure 5-12. Sample Boot Router Window

2. Delete the text displayed in the Configuration box and replace it
with the name pilot.cfg.

3. Click on the Boot button.

Note: The software image and configuration file revert to their
respective default volumes and file names (example: bn.exe and
config) after every boot unless you specify a different
configuration file when you boot. To change the default boot or
configuration file, use the Copy option to back up the old default
file. Then use the Copy option again to overwrite the old default
file with the new default file.

Once you have successfully rebooted the router with the pilot
configuration, the Quick-Start procedure is complete. The router is
now operating on the network with two IP interfaces configured. You
should now do the following:

o Enhance the pilot.cfg file for the router to match your network
requirements.

o Restrict read/write access to the router.

0 Set the router to secure mode.
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Enhancing the Pilot Configuration File

The Configuring Wellfleet Routers guide describes how to use Site
Manager to enhance the pilot configuration file. That is, it describes
how to do the following:

0 Define the rest of the router’s interfaces.
0 Modify the Site Manager default parameter settings.

o Implement optional features (for example, route filters) on the
router.

It also describes how to create new configuration files in any one of the
three operating modes: remote, local, and dynamic.

At this point, you probably want to define additional interfaces for this
configuration file. See Configuring Wellfleet Routers for instructions.

Note: Be sure to start with the file named pilot.cfg when enhancing
the configuration.

Restricting Read/Write Access to the Router

Site Manager uses SNMP to monitor and control the router. To
safeguard against unauthorized SNMP access to the router, we
recommend that you restrict read/write access on the router as soon as
possible. You restrict read/write access by reconfiguring the SNMP
community named “public.”

When you run the Quick-Start installation script (the install.bat file)
and take the default community, the script creates a read/write SNMP
community named “public” with a wild card manager (0.0.0.0). We
strongly recommend that you restrict this read/write access to the
router as follows:

1. Delete the “public” community and create a read/write community
with its own name (for example, WFSM) and a manager list
containing the IP addresses of the Site Manager workstations that
need access to the router.
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2. Reconfigure the “public” community to be read-only with universal
access.

See Configuring Wellfleet Routers for instructions on how to perform
these two steps.

Setting the Router to Secure Mode

Wellfleet routers have an optional security mechanism for all SNMP
SET requests. This proprietary mechanism solves some of SNMP’s
security problems until a stable, widely accepted industry-standard
security solution is available.

When you enable the security mechanism, the router is operating in
secure mode. In secure mode, a Site Manager SET request to the router
includes the encrypted value of a counter. When the agent on the
router receives the SET request, it compares the encrypted value with
the value of its own counter plus one. If the two counters match, the
agent considers the SET request authentic, increments the counter by
two, stores it in an encrypted form in the MIB, and sends it back to
Site Manager.

The security mechanism protects against these security violations:

a  Message stream modification, in which an intruder reorders,
delays, or replays SET requests in order to specify unauthorized
management settings.

0 Masquerade operations, in which an intruder assumes the identity
of an authorized party to specify unauthorized management
settings.

The security mechanism does not protect against the following security
violations, which are beyond the scope of our proprietary interim
security system:

a  Modification of information, the situation in which an intruder
intercepts a packet, modifies its contents, and reinserts it into the
message stream before the agent’s counter is incremented.
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a  Disclosure, in which an intruder observes which variables are being
set.

Enabling the security mechanism only minimally affects router
performance. The security mechanism has no effect on the ability of
Site Manager, or of any SNMP network manager, to monitor the router
by performing GET, GET-NEXT, or trap functions. The next section
describes the procedure for enabling secure mode.

Specifying Secure Mode

Using the Technician Interface, set the router to operate in secure
mode by completing the following steps:

1. Enter the following command:
wfsnmpmode 3

where 3 indicates that the router should operate using the
proprietary security mechanism.

2. Specify the key that the encryption algorithm uses when it
encrypts the security counters by entering the following command:

wfsnmpkey <key >

where <key > is the string of ACSII characters that make up the
encryption key for this router. The key can be no longer than six
characters.

The encryption algorithm uses the attributes of the key (size,
range, and value) as integral parts of its encryption process. Also,
when Site Manager issues the first SET request within an
application, the user must enter this key as a password that
enables the Site Manager to operate in secure mode.

See Using Technician Interface Software for more information about
using the Technician Interface.
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